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16 Información geográfica voluntaria
Serena Coetzee, República de Sudáfrica

16.1 Introducción

En un principio, la World Wide Web contenía únicamente 
información estática que solo permitía su lectura. No 
obstante, con el tiempo se ha transformado en una 
plataforma interactiva, conocida ya como la Web.2.0, 
donde se añaden y actualizan contenidos en todo 
momento y en tiempo real. Fenómenos tales como 
el blogging, las wikis, el videosharing (intercambio de 
vídeos) y las redes sociales, son ejemplos de la Web.2.0. 
Este tipo de contenido es conocido como «contenido 
generado por el usuario». 

La Información Geográfica Voluntaria (IGV) es un tipo 
especial de contenido generado por el usuario. Hace 
referencia a la información geográfica recopilada y 
compartida voluntariamente por el público en general. 
La Web 2.0 y los avances asociados con las tecnologías 
de la cartografía a través de la web, han mejorado en 
gran medida las capacidades para recopilar, compartir e 
interactuar con la información geográfica disponible en 
línea y una consecuencia de ello es la IGV. 

El crowdsourcing es el método o procedimiento de 
efectuar una determinada tarea, tal como la resolución 
de un problema o la recogida de información, a 
través de una llamada o petición abierta al público de 
colaboración; eso supone una cooperación colectiva 
llevada a cabo por personas que participan en ello a 
través de la red. En lugar de elegir a una persona o a 
una empresa para recopilar la información, se integran 
muchas contribuciones individuales con el fin de efectuar 
la tarea. Las contribuciones se realizan habitualmente en 
línea, a través de un sitio web interactivo. 

En las subsecciones siguientes, se describen ejemplos 
de crowdsourcing y aportación de Información 

Geográfica Voluntaria (IGV), tales como: OpenStreetMap, 
Tracks4Africa, el Southern African Bird Atlas Project 2- 
SABAP2 (Proyecto de Atlas de Aves del Sur de África2) 
y WikiMapia. Y en otras subsecciones posteriores 
se proporciona una guía, paso a paso, sobre cómo 
contribuir a OpenStreetMap.

16.2 OpenStreetMap 

OpenStreetMap (www.openstreetmap.org) es un 
proyecto de colaboración para crear mapas del mundo, 
libres y que se puedan editar. Dos de los principales 

factores impulsores de la creación y del desarrollo de 
OpenStreetMap han sido, por un lado, las restricciones 
sobre el uso o disponibilidad de la información 
geoespacial en una gran parte del mundo y, por otro, la 
aparición de dispositivos portátiles de navegación por 
satélite de bajo coste. 

Creado por Steve Coast en el Reino Unido, en 2004, 
fue inspirado por el éxito de Wikipedia y el predominio 
de datos de mapas que no eran de  libre acceso al 
público en general, tanto en el Reino Unido, como en 
otros lugares. Desde entonces, OpenStreetMap ha 
crecido hasta contar con más de un millón de usuarios 

Figura 16.1. La página web de OpenStreetMap.
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registrados, que pueden aportar datos mediante 
dispositivos GPS, fotografías aéreas y otras fuentes de 
información gratuitas. Esos datos, obtenidos a través 
de crowdsourcing, están disponibles bajo una Licencia 
Open Database. Ese sitio está apoyado por la Fundación 
OpenStreetMap, que es una organización sin ánimo de 
lucro registrada en Inglaterra. 

Más que el mapa en sí, son los datos generados por el 
proyecto OpenStreetMap los que constituyen su principal 

aportación. Estos datos están disponibles para su uso 
tanto en aplicaciones tradicionales, como Craigslist, 
Geocaching, MapQuest Open, el software estadístico 
JMP y Foursquare para reemplazar a Google Maps, como 
en tareas menos corrientes, tales como la sustitución de 
datos incorrectos incluidos en receptores GPS. Los datos 
de OpenStreetMap han sido favorablemente comparados 
con otras fuentes de datos con propietarios (derechos de 
autor), aunque la calidad de los datos varía a lo largo del 
mundo [Fuente: Wikipedia].

16.3 Tracks4Africa 

Tracks4Africa (www.tracks4africa.org) comenzó como 
una afición, en el año 2000, a modo de foro, donde 
personas con ideas afines ya compartían sus puntos 
de interés o rutas GPS en el año 2000. Debido a la 
ausencia de mapas útiles para la navegación GPS en 
África, esa afición se convirtió en una comunidad de 
personas que comparten entre sí sus experiencias 
de viaje por dicho continente. Tracks4Africa, como 
empresa, se ​​estableció en 2003 con el fin de recoger 
y guardar toda esa información tan útil. Tracks4Africa 
además ha empezado a elaborar un mapa singular de 
África a base de utilizar exclusivamente los datos GPS 
aportados por la comunidad. Ese mapa es la base de 
los mapas T4A GPS y de todos sus otros productos. En 
el año 2005, Tracks4Africa comenzó a vender mapas 
T4A GPS a gente no perteneciente a la comunidad de 
viajeros que contribuyen a los datos de Tracks4Africa. La 
empresa tiene como objetivo lograr un equilibrio entre 
los datos recogidos por crowdsourcing, un desarrollo de 
sus productos impulsado por la comunidad y un modelo 
comercial sostenible [Fuente: Sitio Web Tracks4Africa]. 

16.4 Southern African Bird Atlas Project 2-SABAP2 
(Proyecto de Atlas de Aves del Sur de África 2) 

El Southern African Bird Atlas Project 2-SABAP2 (Proyecto 
de Atlas de Aves del Sur de África 2) (http://sabap2.adu.
org.za) es la continuación del primer proyecto Southern 
African Bird Atlas Project-SABAP. El primer proyecto de 
atlas se llevó a cabo desde 1987 hasta 1991. El proyecto 
actual constituye una empresa conjunta entre la Unidad 
de Demografía Animal de la Universidad de Ciudad 
del Cabo en Sudáfrica (Animal Demography Unit at 
the University of Cape Town in South Africa), Bird Life-
Sudáfrica y el Instituto Nacional de Biodiversidad de 
Sudáfrica (South African National Biodiversity Institute-
SANBI). El proyecto tiene como objetivo determinar la 
distribución y abundancia relativa de las aves en el Sur de Figura 16.2 La página Web de Tracks4Africa.

http://sabap2.adu.org.za
http://sabap2.adu.org.za
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África. Este segundo proyecto de atlas comenzó el 1 de 
julio de 2007 y el plan es que funcione indefinidamente. 

El trabajo de campo para este proyecto es llevado a 
cabo por más de mil voluntarios –conocidos como 
«ciudadanos científicos»– que recogen datos en el 
campo en su tiempo libre, pagando los gastos ellos 
mismos y con ello, realizando una gran contribución 
a la conservación de las aves y su hábitat. La unidad 
espacial de recogida de datos es la «pentada» (pentad), 
consistente en cinco minutos de latitud por cinco 
minutos de longitud, es decir, cuadrados con lados de 
aproximadamente 9 km. Hay unas 17.000 «pentadas» en 
el área de Sudáfrica, Lesoto y Suazilandia, y otras 10.000 
en Namibia [Fuente: Wikipedia]. 

16.5 WikiMapia 

WikiMapia (www.WikiMapia.org) es un proyecto 
cartográfico cooperativo de contenido abierto y 

por tanto gratuito que pretende señalar y describir 
todos los objetos geográficos del mundo. Combina 
un sistema cartográfico interactivo en la web con 
un sistema wiki referenciado geográficamente, que 
permite a los usuarios añadir información en forma 
de notas a cualquier región o localidad del planeta. En 
mayo de 2014, más de 23 millones de objetos han sido 
marcados tanto por usuarios registrados como por 
invitados.

El sitio web de WikiMapia ofrece un mapa web 
interactivo basado en una API de Google Maps, que 
consiste en una capa de información generada por el 
usuario sobre imágenes de satélite de Google Maps y 
otros recursos. 

La capa WikiMapia es una colección de objetos con 
elementos poligonales (como puedan ser contornos de 
edificios, lagos, etc.) y elementos lineales (tales como 
calles, ferrocarriles, ríos, etc.). Ambos tipos de elementos 

pueden tener descripciones de texto y fotos adjuntas 
a ellos. Los usuarios pueden hacer clic en cualquier de 
estos objetos o en un segmento de calle seleccionado, 
para ver su descripción. Se proporcionan instrumentos 
para resaltar gráficamente los objetos por categorías y 
para medir distancias entre los objetos.

Cualquiera puede añadir un nuevo elemento a la 
capa de WikiMapia. Se supone que los objetos y los 
elementos lineales se deben dibujar en la ventana 
principal de modo que coincidan con la imagen de 
satélite subyacente, utilizando una sencilla herramienta 
de edición gráfica. Cuando se crea un objeto, se invita 
al usuario a especificar sus categorías, añadiendo una 
descripción de texto y aportando las fotos pertinentes. 
Solo los usuarios registrados pueden editar elementos ya 
existentes. Los editores pueden crear una «lista a vigilar» 
para controlar todos los cambios que se realicen en una 
o más áreas rectangulares en el mapa. 

La comunidad de editores está en gran medida 
autoorganizada, con los usuarios comunicándose 
de manera privada mediante un sistema de correo 
electrónico, y a través de un foro público. El sistema 
asigna automáticamente «puntos de experiencia» 
para los editores con varias ediciones y los clasifica en 
diferentes niveles de acuerdo a los puntos obtenidos. 
Los de los niveles más altos tienen mayores accesos a 
las herramientas de edición y menos restricciones para 
acceder a la actividad de edición. 

Los editores de los niveles más altos pueden 
ser invitados a ser «moderadores» o «usuarios 
avanzados». Como tales, reciben derechos de 
edición adicionales, acceso a más acciones para la 
monitorización de mapas y autoridad para expulsar 
a ciertos usuarios. La mayor parte del trabajo de 
los «usuarios avanzados» consiste en gestionar y 
dirigir a otros editores, incluyendo el establecimiento 
de normas y la lucha contra el posible vandalismo 
[Fuente: Wikipedia-English]. 

Figura 16.3. Progreso del mapa del Southern African Bird 
Atlas Project 2.

Figura 16.4. La página del mapa WikiMapia.

http://www.wikimapia.org
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WikiMapia permite que sus contribuyentes añadan 
«puntos activos» (hotspots) a cualquier mapa, limitados 
por rectángulos (dentro de una longitud máxima de 20 
kilómetros por cualquiera de sus lados) wikienlazados 
mediante una nota que suministra información sobre 
la localidad referida. Las notas pueden escribirse en 
cualquiera de los 36 idiomas contemplados actualmente 
y pueden ser modificadas por cualquier contribuyente, 
tal como en una wiki.

Los enlaces (links) se activan mediante clics dentro 
de cualquier rectángulo. Una de las características de 
WikiMapia es su visualizador «automóvil» que permite 
hacer enfoques (zooms) hacia dentro y hacia fuera sobre 
las áreas, para reducirlas o agrandarlas respectivamente. 
Y se puede utilizar para explorar, tanto los mapas, como 
las fotografías de satélite.

WikiMapia se puede incorporar a cualquier sitio en 
Internet. Se abre WikiMapia, se selecciona la opción 
deseada y se elige «Mapa en su PÁGINA» del menú. 
El usuario luego selecciona las coordenadas del mapa 
e inserta el código HTML indicado en el sitio. [Fuente: 
Wikipedia-Español].

16.6 Familiarizándose con OpenStreetMap 

Los ejercicios que se describen en esta sección le 
ayudarán a familiarizarse con OpenStreetMap (es 
decir, cómo buscar lugares, cómo moverse dentro 
de la ventana de mapa y cómo compartir mapas de 
OpenStreetMap con los amigos). 

Ejercicio 1: Vaya a la página de OpenStreetMap en www.
openstreetmap.org,  y busque «Universidad de Pretoria». 
Haga clic en el tema correspondiente, en la barra lateral 
de los «Search Results» (Resultados de la búsqueda), 
para situar el mapa alrededor de la universidad. Cierre 
la barra lateral de «Search Results»  cuando haya 
terminado.

El mapa es navegable con un ratón, como cualquier otro 
mapa en línea. Uno puede desplazarse o «arrastrar» el 
mapa hasta la ubicación deseada, acercarlo (zoom in) o 
alejarlo (zoom out), etc. 

Ejercicio 2: Cierre la ventana «Search Results» pulsando 
la X en la esquina superior derecha. Aleje el mapa 
(utilizando las teclas + y - en el menú de la derecha) hasta 
que la barra de escala (en la esquina inferior izquierda) 
muestre 50 m.

Ejercicio 3: Mueva el mapa hacia el Oeste (haga clic y 
mantenga pulsado el ratón, arrastrándolo a la derecha), 
hasta que aparezca el estadio Loftus Versfeld en el lado 
izquierdo del mapa.

Hay diferentes formas de ver datos de OpenStreetMap 
en la página principal del mapa, dependiendo de sus 
preferencias personales o el propósito perseguido (por 
ejemplo, el senderismo, el ciclismo o el turismo). La 
página de OpenStreetMap ofrece algunas alternativas, 
incluyendo mapas para ciclismo y transporte. Otros 
sitios web muestran los datos de OpenStreetMap 
para su propio propósito específico. Algunos ejemplos 
incluyen la OpenPisteMap (www.openpistemap.org) 
que muestra pistas de esquí, o mapas de geocaching 
(www.geocaching.com) que muestran las ubicaciones de 
geocachés escondidos. 

Figura 16.5. En busca de la Universidad de Pretoria 
(Ejercicio 1).

Figura 16.7. Vista panorámica del Estadio Loftus Versfeld 
(Ejercicio 3). 

Figura 16.6. Ampliación hasta que la barra de escala sea 
de 50m (Ejercicio 2). 

http://www.openstreetmap.org
http://www.openstreetmap.org
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Ejercicio 4: Haga clic en el icono «Layers» (Capas) ( ) 
para abrir la barra lateral de capas del mapa y seleccionar 
para ver los diferentes estilos de mapa.

Los mapas se pueden compartir con amigos y colegas, 
por ejemplo, para comunicar el lugar de una reunión de 
negocios o de una fiesta de cumpleaños. 

Ejercicio 5: Haga clic en el icono «Share» (Compartir) 
 ( ) para abrir la barra lateral Compartir. Copie el 
hipervínculo en el campo de abajo «Link | Short Link | 
HTML», cree una nueva pestaña en el navegador, pegue el 
texto y pulse «Enter» (Intro). Se va a mostrar exactamente 
el mismo mapa que usted tenía en la primera pestaña. 
Si selecciona «Include marker» (Incluir marcador), se 
muestra un marcador rojo en el mapa.

Se dará cuenta de que la URL es muy larga. Haga clic 
en «Short Link» para obtener una URL más corta, que 
igualmente le redirija a la misma URL que era más larga. 

Puede compartir este mapa con amigos o clientes, 
mediante el envío del hipervínculo completo o acortado, 
en un correo electrónico. 

Los mapas también pueden insertarse en las páginas 
HTML de una página o sitio web, por ejemplo, para 
mostrar la ubicación del colegio, la escuela o el lugar de 
celebración de un evento deportivo (véase también la 
figura 16.11). 

Ejercicio 6: Haga clic en el icono «Share» (Compartir)
( ) para abrir la barra lateral Compartir y haga clic en 
«HTML». Copie el fragmento de código HTML del cuadro 
de texto en el portapapeles (por ejemplo, con Ctrl-C). 
Utilice cualquier editor de texto para crear un archivo 
HTML y pegue el texto del portapapeles en el archivo 
HTML (por ejemplo, con Ctrl-V). Delimite el texto con las 
etiquetas <html> y <body>. Véase la figura 16.10. Abra el 
archivo HTML en un navegador (por ejemplo, mediante 
el uso de File > Open). Como alternativa, puede hacer 
doble clic en el archivo HTML, para mostrarlo en un 
navegador. Véase la figura 16.11.Figura 16.8. Visualización de los datos de OpenStreetMap 

como un mapa de transporte (Ejercicio 4). 

Figura 16.10. Una página básica HTML con un mapa 
insertado de OpenStreetMap (Ejercicio 6).

Figura 16.11. Muestra el código HTML de la figura 16.6 
en un navegador (Ejercicio 6).

Figura 16.9. La dirección de esta página (URL) fue 
copiada y pegada de la barra lateral Compartir. Fíjese en 
el marcador rojo (Ejercicio 5). 
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Por último, también se puede descargar la imagen del 
mapa actual, por ejemplo, como PNG o PDF.
 
Ejercicio 7: Haga clic en el icono «Share» (Compartir)
 ( ) para abrir la barra lateral Compartir. Elija 
un formato de la lista desplegable (el formato 
predeterminado es PNG). Haga clic en el botón 
«Descargar» (Download). Véase la figura 16.12.

16.7 Contribuir a OpenStreetMap 

Los datos de OpenStreetMap son un claro ejemplo 
de crowdsourcing: los datos son recogidos y 
proporcionados por más de un millón de contribuyentes 
por todo el mundo. Cualquier usuario registrado puede 
contribuir a los datos de OpenStreetMap, añadiendo 
elementos individuales, como vamos a hacer en 
los próximos ejercicios, u ofreciendo conjuntos de 
datos completos para ser importados (http://wiki.
openstreetmap.org/wiki/Import). Algunos usuarios 
llevan dispositivos GPS en sus paseos a pie, en trayectos 

en coche, o durante excursiones en bicicleta, para 
registrar trazas que luego pueden ser importadas 
desde OpenStreetMap. Otros contribuyen trazando 
en el mapa carreteras y elementos que observan en 
las imágenes de satélite. Hay una serie de tutoriales 
disponibles en muchos idiomas diferentes. Todo lo 
que se necesita es un ordenador conectado a Internet, 
y tiempo para recoger y recopilar la información e 
introducirla en el ordenador. Tanto un dispositivo GPS 
como su cable de conexión son meramente opcionales. 

En ejercicios posteriores vamos a agregar a 
OpenStreetMap elementos puntuales, lineales y de área. 

Ejercicio 8: Siga las instrucciones de la Beginner´s Guide 
(Guía para principiantes) en OpenStreetMap
(http://wiki.openstreetmap.org/wiki/Beginners_
Guide_1.0) para crear una cuenta gratuita de usuario en 
OpenStreetMap. Haga zoom sobre un área que sea de su 
interés y haga clic en el botón «Edit» (Editar) para iniciar 
una sesión en la herramienta de edición. Léase el texto de 
la introducción. 

Puede volver a la vista del mapa en cualquier momento 
(haciendo clic en el logotipo de OpenStreetMap) para 
localizar otra área diferente de interés en el mapa. Una 
vez que haga clic en el botón «Edit», el editor de mapas 
se actualiza y muestra la vista del mapa actual.

Ahora va a comenzar a añadir datos. En primer lugar 
un punto de interés, a continuación el contorno de un 
edificio y, finalmente, un camino. 

Ejercicio 9: Busque un área con la que usted esté 
familiarizado y en donde se puede añadir un punto 
de interés. Haga clic en el botón «Edit» y haga clic en 
«Point» ( ) (Punto) en el menú superior. Haga clic 
en el mapa donde se va a agregar el punto de interés. 
Seleccione el tipo de elemento (véase la figura 16.14) y, 
posteriormente, añada la información de los atributos del 
punto de interés (véase la figura 16.15). Haciendo clic en la 
«i» ( ) junto al nombre del atributo, se proporciona una 
descripción del atributo, si es que la hay. Hay disponibles 
una serie de atributos adicionales haciendo clic en la fila 
de iconos situados en la parte inferior.

Figura 16.12. La descarga de una imagen de un mapa 
(Ejercicio 7). 

Figura 16.13. La herramienta predeterminada de edición 
de OpenStreetMap (Ejercicio 8).

Figura 16.14. Indicando la ubicación y seleccionando el 
tipo de elemento de un punto de interés (Ejercicio 9). 

http://wiki.openstreetmap.org/wiki/Import
http://wiki.openstreetmap.org/wiki/Import
http://wiki.openstreetmap.org/wiki/Beginners_Guide_1.0
http://wiki.openstreetmap.org/wiki/Beginners_Guide_1.0
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Las etiquetas se utilizan para describir un punto de 
interés (u otro objeto geográfico). Puede añadir o quitar 
etiquetas para describir el lugar de interés que va a 
agregar. Por ejemplo, las etiquetas de un restaurante 
podrían ser: establecimiento, nombre y tipo de cocina. 
De forma predeterminada, los valores de estas variables 
se establecen en los valores de los atributos.

Haga clic en «Save» (Guardar) en el menú superior 
para guardar el punto de interés en OpenStreetMap. 
Además, tiene la oportunidad de añadir un 
comentario antes de confirmar el lugar de interés 
haciendo clic en el segundo botón «Save» (Guardar). 
Si ahora cambia de nuevo a la vista del mapa, el punto 
de interés ya se muestra en OpenStreetMap (véase la 
figura 16.16). Es posible que tenga que esperar unos 
segundos para que los cambios sean visibles (actualice 
repetidas veces la ventana del navegador hasta que 
sean visibles). 

Haga clic en el botón «History» (Historial). Se muestra 
una lista de los conjuntos de cambios. Haga clic en el 
primer elemento de la lista. Se muestran los detalles del 
cambio en OpenStreetMap (véase la figura 16.17).

Ejercicio 10: Familiarícese con la herramienta de 
edición de OpenStreetMap añadiendo más puntos de 
interés, moviéndose alrededor de los puntos de interés 
existentes y modificando los atributos de un punto de 
interés existente.

Ejercicio 11: En la vista del mapa, busque un área con la 
que usted esté familiarizado. Haga clic en el botón «Edit» 
(Editar) y haga clic en «Area» (Área) en el menú superior. 
Indique los límites del área que desea agregar en el mapa 
y pulse «Escape» cuando haya terminado. Siga el mismo 
procedimiento que en el ejercicio 8, para especificar el 
tipo de elemento y para completar los atributos.Figura 16.15. Especificando los atributos de un punto de 

interés (Ejercicio 9).

Figura 16.18. Añadiendo un elemento de área
(Ejercicio 11). 

Figura 16.19. Añadiendo un elemento lineal
(Ejercicio 12).

Figura 16.17. Los detalles del conjunto de cambios en la 
ficha Historial para el nuevo punto de interés (Ejercicio 9). 

Figura 16.16. El nuevo punto de interés en 
OpenStreetMap (Ejercicio 9).
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Ejercicio 12: En la vista del mapa, busque un área con la 
que usted esté familiarizado, con un elemento lineal (por 
ejemplo, una calle o un camino) que pueda ser añadido. 
Haga clic en el botón «Edit» (Editar) y haga clic en «Line» 
(Línea) en el menú superior. Indique el elemento lineal 
que desea agregar en el mapa y pulse «Escape» cuando 
haya terminado. Siga el mismo procedimiento que en el 
ejercicio 8, para especificar el tipo de elemento y para 
completar los atributos.

16.8 Conclusión 

La IGV y el crowdsourcing se están convirtiendo en 
una fuente muy importante de información geográfica, 
particularmente en lo que respecta a información 
que es difícil de recoger. Sin embargo, hay que tener 
en cuenta que las contribuciones de la IGV no están 
necesariamente verificadas y su calidad no está 
contrastada de la manera que sí ocurre con las fuentes 
cartográficas tradicionales. ¡Les animo a contribuir a 
OpenStreetMap allá donde vivan!
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